e = ate e

%

SR

N

W
;]

HR DATA ANALYTICS

WORKSHOP NOTES

O’BRIAN EBANKS



2 W. O’Brian Ebanks | obrian.ebanks@gmail.com



Table of Contents

(Y 1 F= 1Y o ol PSP 5
TYPES OF DAtA ANAIYTICS ..eeeeiiiiiiee ettt e ettt e et e e s e b bt e e e e aab bt e e e sabb et e e eanbaeeessanrbeeeeenrraeeeas 5
Current Best PractiCes (BEAI).........uuuiiiiiiiieeee ettt ee ettt e e e e e e e e et e e aeeeeaaaeeeeeaaastbbaseeeeaaeeeeeasnnnnnnnes 5
Top Five HR Metrics (OtterSense TEAM, 2017) ..uuueiiiieeeeiiccciiireieeeeeeeeeeesseettrrreeeeeeeeeeesssnnassasaseeeaeeeessssnnnsssnnsesees 6

Readily Available Business Software — Introduction to MicrosSoft EXCEl........uuuiiiiiiiiiiiiiiiiiiiiieeeee e ecsiiieeeee e e e 7
THE RIBDON IMIENU .ttt et e b e e bt e s a bt e e b bt e e bt e e eabe e e eabeeesabeeeabbeeeabaeesabeeesaseean 7
o T == T =T o L= PSP 10
F AT o) ]| I T 4 oY o F OO UTPUUPPPUUPPRt 10
Turn Automatic Completion of Cell Values On or Off ..........uuiiiiiiiiiiic e 10
Fill Data into Adjacent Cells by Using the Fill HANdIE ............ouviiiiiiiiieeeeeeee e 11
Fill in a series of numbers, dates, or other built-in series iteMS .........ooovvviiiiiiiiiiiccccee e 13

IMIS EXCEI FUNCLIONS ...ttt ettt ettt ettt et e bt e sttt e sab e e shb e s bt e e sab b e e sab e e e et e e aabbeeeabeeeaabeeesabeeeanbeeanneeesanes 14
Using the sUMMation DULLON ........uiiiiiiiie e e e e e e e e e e e e e e e e s ae et e areeeeeeeeeeesnnnnennnneees 14
V11 a = = [T =l - 10 1= L PP UPTTPRRPRPPPRt 14
USEFUL FUNCEIONS ..ttt e sttt e st e st e e s ab e e sb e e sabeeesabeeesabeeenbbeeennbeesabeeenas 17
TO USE The SUM FUNCLION ....ciiiiiiiiee ettt et e st e st et e e mr e e be e e seneeessneeenne 17
TO USE the COUNT FUNCHION: ....iiiiiiiiiieei ettt e ettt e e e e e s s bbe e e e e e bbbt e e s saneeeeseanrneeens 18
To USE the AVERAGE fUNCHION: «...eeiiiiiieietee ettt ettt ettt e sa e et esbe e e sabeeesabe e enmbeeeneeesanes 18
To use MAX and MIN fUNCHIONS: ...coouiiiiiiiee ettt se e sene e e e e sanes 19
Using the function (fx) button in the top tOO0IDAT ..........ii i e 19

Calculating Data with Advanced FOrMUIAS ...........uuviiiiiiiii it e e e e e e e e e e et aa e e e e e e e e e e e e nanasasaeees 20
Manage Cell and RANGE NAMES......uveviiriiiiieseerereteesee st esteerte e st e sseessseesteesseessseesseesseesseesnseeseesseesssesnseessessnnes 20
Calculate Data ACIOSS WOIKSNEEES.........couiiieiiiteeierieete ettt sttt ettt sb et bt sbe et sbe et e sbe et e sbeeaeennens 22

Sum the value of a cell across Multiple WOrKSHEELS.........ccviiiieiieie et reens 22
Enter data in multiple worksheets at the SAME tiMEe.......cccvoviiiiiiiece e e 23

USE SPECIAIIZEA FUNCLIONS ...ttt sttt e et e e s s ab et e e e aa b bt e e s s amnteeeeeanbbeeeesannreeeenans 23

Analyze Data with Logical and LOOKUP FUNCLIONS ..........uuiiiiiiiieiieeeecciiiie ettt e e e e e e e e e esiiarr e e e e e eeaaeeas 23
AND FUNCEION ..ttt ettt et e st e s bt e e s r e e e aa e e s ne e e sne e e saneeesmreeesnneesnnees 23

OR FUNCEION 1.ttt ettt e a e e bt e e sttt e e abe e e bt e e s bt e e sabeeesabeeesbbeesabbeesabaeesabeeennbeesbneanas 24

1 {0 g Tot o o HA P PO OO TP O PSPPSRSO PRPOPPPRN 25
VLOOKUP FUNCHION .ttt et et et e s e e s ene e e sea e e s mn e e s e e e saneeesanees 26

FeYe L g ALY ) ol a W =TT Vo A o) o WSRO 27
Presenting Data USING Carts ......cooiceoiiiiiiiiiiee ettt e e e e e e e e e ettt b e e e e e aeeeseeeeanasssaaaaeaaaaeessssssssssaseeaaaaaaeeeannees 30

3 W. O’Brian Ebanks | obrian.ebanks@gmail.com



(01T I 1O o = [ TR 30

Analyzing Data Using PivotTables and PIVOTCNAItS. .........uuiiiiiiiiieccccciiiiiieee ettt e e e e e st e e e e e e e e e e e e eanans 33
(01 LI T o Voo =] o] 1T 2 U=T o To ) SRS 33
Fi oo 1= o Lo [ PP O PP P P PP ROPPPTPPP 35
[l o To =10 B o o el U1 £SO UUUPURRY 35
A oLy O =T o OO P R PPPPI 35

4 W. O’Brian Ebanks | obrian.ebanks@gmail.com



Data Analytics
Data Analytics is the process of organizing raw data to be able to make meaningful decisions out of the
information. When used, data analytics can contribute to the optimization of performance all areas of a business.

Data Analytics comes in many forms, from complex and often expensive artificial intelligence systems to less
expensive and readily available techniques using Microsoft Excel.

Data analytics is used to reveal trends using metrics on large volumes of data that can often get lost. It provides
insights and helps, in a meaningful way, to make strategic decisions in many areas. In manufacturing, it may be
used to determine the efficiency of a production line, or influence what to produce next based on logistical data
and consumer need. In Sales it can be used to determine how to upsell to a customer based on purchasing habits.
In Marketing it can be used to determine the effect of a marketing campaign on a brand or how to get a customer
o like a product or click a link. In HR it can be used to determine talent retention rate, recruitment efficiency, profit
per employee and the effectiveness of employee engagement efforts.

Types of Data Analytics

Data analytics is broken down into four basic types. (Frankenfield, 2019)

e Descriptive analytics describes what has happened over a given period of time. Have the number of views
gone up? Are sales stronger this month than last?

e Diagnostic analytics focuses more on why something happened. This involves more diverse data inputs
and a bit of hypothesizing. Did the weather affect beer sales? Did that latest marketing campaign impact
sales?

e  Predictive analytics moves to what is likely going to happen in the near term. What happened to sales the
last time we had a hot summer? How many weather models predict a hot summer this year?

e  Prescriptive analytics suggests a course of action. If the likelihood of a hot summer is measured as an
average of these five weather models is above 58%, we should add an evening shift to the brewery and
rent an additional tank to increase output.

Current Best Practices (Beall)

Realize there is no silver bullet, but don’t do nothing.

Building an analytics culture and putting the ecosystem together takes time. It’s important not to try to boil the
ocean. However, it’s also important not to ignore the work and simply hope success will magically happen.
Companies that are measuring value with analytics are taking risks, experimenting, and finding success. It may take
time.

Start with a proof of concept.
Companies succeeding with analytics often start with a model using data they are already measuring, so they can
demonstrate that they can predict that model.

If you have not been collecting data, start by asking one question (this can be based on the business strategy) then
look at what data would need to collect to answer the question.

Take training seriously.

Think about the skills you will require for data management, as well as the skills to build your metrics and deal with
your data. With statisticians and other quants in short supply, think about what skills you’ll need for the kinds of
metrics you want to build. Part of the process is balancing the costs and benefits of what you are considering.
Allocate your resources wisely. Training will become an important part of your next-generation strategy.
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Act on your data.
Analytics without action won’t yield measurable impact. Even if you aren’t ready to operationalize your analysis, it

makes sense to start implementing a process to act, even if it's manual action. You’ll be building a more analytically
driven culture.

Build a center of excellence.
A CoE can be a great way to make sure that the infrastructure and analytics you implement are coherent. CoEs can
help you disseminate information, provide training, and establish or maintain governance.

Remember to monitor your analysis.
Data can get stale. Data models can get stale. It's important to revisit any kind of analysis where action is taking
place on a periodic basis to make sure that your data is still relevant and that your model still makes sense.

Top Five HR Metrics (OtterSense Team, 2017)

Revenue Per Employee *Revenue / # Employees

Employee Net Promoter Score
(eNPS)

*% who are promoters — % who are detractors

o# employees who left within the last 12 months/ # of new hires over the last

Early Turnover Rate 12 months.

Overall Turnover Rate o# employees who leave / # employees at the beginning of the period

Time to Fill eAverage of the # days between job posting to an offer signed
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Readily Available Business Software - Introduction to Microsoft

Excel

The Ribbon Menu
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FIGURE 1 THE HOME MENU
The home menu contains the most used tools. It is where tools such as:
e Conditional formatting
e Number formatting
e Quick access functions such as sum and average
e Sort and filter data arrays
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FIGURE 2

THE INSERT MENU

The insert menu contains objects that add functionality and interest to excel. Every item selected from the insert
menu will generate its own specific menu bar. The insert menu contains items such as:

Pivot tables
Tables

Pictures

SmartArt

Graphs and charts
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FIGURE 3 THE PAGE LAYouT MENU
The page layout menu is all about printing. It contains tools such as:
e Page orientation
e Margins
e Scale tofit
e  Print titles
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FIGURE 4 THE FORMULAS MENU
The formulas menu contains a summary of the functions that are currently available in excel nicely categorized by
function type. Some of the common function categories are:
e Logical
e Text
e Date andtime
e Lookup and reference
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FIGURE 5 THE DATA MENU
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The data menu has the data capture and transformation tools. It has very powerful tools such as:

e GetData

e Sort and Filter (Also found on the home menu, it is that important)
e Textto column

e Data validation

File Home Insert Page Layout Formulas Data Review View Help 1% Share
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FIGURE 6 THE REVIEW MENU

The review menu is used for review or commenting on the spreadsheet. It has powerful and sometimes
underutilized tools such as:

e  Spell Check
e Comments and Notes
e Protect Sheet and Workbook
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FIGURE 7 THE VIEW MENU

The view menu is all about what is seen on the screen. It is how excel is viewed on a monitor and adding features

that help improve interactions with excel at a point in time. It has menu items such as:

e  Page break view
e  Page layout view
e Freeze Panes

e Zoom
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Filling a series
Say you want to fill column A, starting in cell A2, with the values 1, 2, and so on up to 1000. There is an easy way.

To fill a column range with a series:

Enter the first value in the first cell (1 in cell A2). With the cursor in the starting cell (A2), use the menu item
Edit/Fill/Series to obtain a dialog box. Change the Row setting to Column, make sure the Type setting is Linear,
make sure 1 is in the Step Value box, enter the final value (1000) in the Stop Value box, and click on OK.

As you can guess from this dialog box, many other options are possible. Don’t be afraid to experiment with them.

Try it! The series of days in column A should go from 1 to 25, in column D it should go from 26 to 50.

Day Sales Day Sales
$227 $167
$157 $107
$143 $255
$129 $113
$102 $186
$116 $124
$269 $271
$111 $288
$210 $273

FIGURE 8 FILL SERIES

Autofill Options

Automatically repeat values that already exist in the column

If the first few characters that you type in a cell match an existing entry in that column, Excel automatically enters
the remaining characters for you. Excel automatically completes only those entries that contain text or a
combination of text and numbers. Entries that contain only numbers, dates, or times are not automatically
completed.

After Excel completes what you started typing, do one of the following:
e To accept a proposed entry, press Enter.

The completed entry exactly matches the pattern of uppercase and lowercase letters of the existing entry.!
e Toreplace the automatically entered characters, continue typing.

e To delete the automatically entered characters, press Backspace.

Turn Automatic Completion of Cell Values On or Off
If you don't want Excel to automatically complete cell values, you can turn off this feature.

1 Excel completes an entry only when the cursor is at the end of the current cell contents.

Excel bases the list of potential AutoComplete entries on the column that contains the active cell. Entries that are repeated within a row
are not automatically completed.
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1. Click the File tab, and then click Options.

2. Click Advanced, and then under Editing options, select or clear the Enable AutoComplete for cell
values check box to turn automatic completion of cell values on or off.

Fill Data into Adjacent Cells by Using the Fill Handle

To quickly fill in several types of data series, you can select cells and drag the fill handle —i . To use the fill
handle, you select the cells that you want to use as a basis for filling additional cells, and then drag the fill handle
across or down the cells that you want to fill.

By default, the fill handle is displayed, but you can hide it, or show it if it's hidden.

After you drag the fill handle, the Auto Fill Options button is displayed. If you don't want to display the Auto Fill
Options button every time that you drag the fill handle, you can turn it off. Likewise, if the Auto Fill Options button
does not appear when you drag the fill handle, you might want to turn it on?.

Drag the fill handle to fill data into adjacent cells
1. Select the cells that contain the data that you want to fill into adjacent cells.
2. Drag the fill handle across the cells that you want to fill.
3. To change how you want to fill the selection, click Auto Fill Options , and then click the option that
you want.

For example, you can choose to fill just cell formats by clicking Fill Formatting Only, or you can choose to fill just
the contents of a cell by clicking Fill Without Formatting.

Note: If you drag the fill handle up or to the left of a selection and stop in the selected cells without going past the
first column or the top row in the selection, Excel deletes the data within the selection. You must drag the fill
handle out of the selected area before releasing the mouse button.

Turn Auto Fill Options on or off
1. Click the File tab, and then click Options.

2. Click Advanced, and then under Cut, copy, and paste, select or clear the Show Paste Options button
when content is pasted check box to turn this option on or off.

Fill data into adjacent cells by using the Fill command

You can use the Fill command to fill the active cell or a selected range with the contents of an adjacent cell or
range.

1. Do one of the following:

2 show or hide the fill handle

Click the File tab, and then click Options.
Click Advanced, and then under Editing options, select or clear the Enable fill handle and cell drag-and-drop check box to
show or hide the fill handle.

3.  To avoid replacing existing data when you drag the fill handle, make sure that the Alert before overwriting cells check box is
selected. If you don't want to see a message about overwriting nonblank cells, you can clear this check box.
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o Tofill the active cell with the contents of an adjacent cell, select an empty cell that is below, to
the right, above, or to the left of the cell that contains the data that you want to use to fill the
empty cell.

o Tofill multiple adjacent cells, select the cell with the contents you want to fill and the adjacent

cells into which you want to fill the content. B
T AutoSum + W !ﬁ
] Fill - -

Sort & Find &
2 Clear ~ Filter = Select ™

Editing

2. Onthe Home tab, in the Editing group, click Fill, and then click Down, Right, Up, or Left.
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To quickly fill a cell with the contents of an adjacent cell, you can press Ctrl+D to fill from the cell above or Ctrl+R to
fill from the cell to the left.

Fill formulas into adjacent cells

1. Select the cell that contains the formula that you want to fill into adjacent cells.
2. Drag the fill handle —i across the cells that you want to fill.
3. To choose how you want to fill the selection, click Auto Fill Options [=**], and then click the option that

you want.

Note: If automatic workbook calculation is not enabled, formulas will not recalculate when you fill cells. To check
your workbook calculation options, do the following:

4. Click the File tab.

5. Under Excel, click Options, and then click the Formulas category.

6. Under Calculation options, look under Workbook Calculation.
o Automatic Formulas automatically recalculate.
o Automatic except for data tables Formulas recalculate, unless the formula is in a data table.
o Manual Formulas never recalculate automatically.

o Recalculate workbook before saving This option is available only if Workbook Calculation is
set to Manual. If this check box is selected, formulas do not automatically recalculate until you
save the workbook. Note that several other actions can cause the workbook to be saved, such as
using the Send To command.

Fill in a series of numbers, dates, or other built-in series items
You can quickly fill cells in a range with a series of numbers or dates, or with a built-in series for days, weekdays,
months, or years by using the fill handle or the Fill command.

Fill cells with a series by using the fill handle
1. Select the first cell in the range that you want to fill.
2. Type the starting value for the series.
3. Type avalue in the next cell to establish a pattern.

For example, if you want the series 1, 2, 3, 4, 5..., type 1 and 2 in the first two cells. If you want the series 2, 4, 6,
8..., type 2 and 4. If you want the series 2, 2, 2, 2..., you can leave the second cell blank.

4. Select the cell or cells that contain the starting values.

5. Drag the fill handle —i across the range that you want to fill.
To fill in increasing order, drag down or to the right. To fill in decreasing order, drag up or to the left.
Note:

6. You can also specify the type of series by using the right mouse button to drag the fill handle over the
range and then clicking the appropriate command on the shortcut menu. For example, if the starting
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value is the date JAN-2007, click Fill Months for the series FEB-2007, MAR-2007, and so on; or click Fill
Years for the series JAN-2007, JAN-2008, and so on.

7. If the selection contains numbers, you can control the type of series that you want to create.

8. You can suppress series AutoFill by holding down Ctrl as you drag the fill handle of a selection of two or
more cells. The selected values are then copied to the adjacent cells, and Excel does not extend a series.

MS Excel Functions

Using the summation button

The SUM function is used so often to sum across rows or columns that a toolbar button (the X button) is available
to automate the procedure. To illustrate its use, suppose you have a table of numbers in the range B3:E7. You
want the row sums to appear in the range F3:F7, and you want the column sums to appear in the range B8:E8. It's
easy.

To produce row and column sums with the summation button:

Select the range(s) where you want the sums (F3:F7 and B8:E8—remember how to select multiple ranges), and click
on the summation button.

Note that if you select multiple cells, you get the sums automatically. If you select a single cell (such as when you
have a single column of numbers to sum), you’ll be shown the sum formula “for your approval” and you’ll have to
press Enter to actually enter it. Why does Excel do it this way—your guess is as good as ours!

Try it! Use the summation button to fill in the row and column sums.

51 94 15 7
37 6 2 41
13 83 29 88
73 64 46 32
38 11 3 80

Using range names

Range names are extremely useful for making your formulas more understandable. After all, which formula makes
more sense: =B20-B21 or =Revenue-Cost? Efficient use of range names takes some experience, but here are a few
useful tips.

To create a range name:

Select a range that you want to name. Then type the desired range name in the upper left “name box” on the
screen. (This box is just above the column A heading. It usually shows the cell address, such as E13, where the
cursor is.)
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You could go through the Insert/Name/Define menu item, but typing in the name box is quicker and more
intuitive. By the way, range names are not case sensitive. For example, Revenue, revenue, and REVENUE can be
used interchangeably.

Try it! Name the rectangular range containing the numbers Data.

71 31 9 69 5
15 74 46 84 27
14 49 25 38 83
40 43 20 75 83
28 72 30 92 75
41 56 90 89 73
28 81 43 81 61

To delete a range name:

Use the Insert/Name/Define menu item. This shows a list of all range names in your workbook. Click on the one
you want to delete, and then click on the delete button.

Try it! The numerical range is currently named Data. Delete this range name and then rename the range
Database.

15 86 50 41 21
63 18 10 1 9
14 52 16 18 65
89 88 28 72 7
15 28 57 92 2
29 90 86 100 83
10 82 100 65 4

Suppose you have the labels Revenue, Cost, and Profit in cells A20, A21, and A22, and you would like the cells B20,
B21, and B22 (which will contain the values of revenue, cost, and profit) to have these range names. Here’s how to
do it quickly.

To create range names from adjacent labels:

Select the range consisting of the labels and the cells to be named (A20:B22). Then use the Insert/Name/Create
menu item, make sure the appropriate box (in this case, Left Column) is checked, and click on OK.

Excel tries (usually successfully) to guess where the labels are that you want to use as range names. If it guesses
incorrectly, you can always override its guess.
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Try it! Name the ranges A3:A8, B3:B8, and so on according to the labels in row 2.

Jan
Feb
Mar
Apr
May
Jun

Month

100
150
200
230
200
300

UnitsSold  UnitPrice

$1.25
$1.25
$1.40
$1.40
$1.50
$1.50

Revenue
$125.00
$187.50
$280.00
$322.00
$300.00
$450.00

Sometimes you have entered a formula using cell addresses, such as =B20-B21. Later, you name B20 as Revenue
and B21 as Cost. The formula does not change to =Revenue-Cost automatically. However, you can make it change
(and hence become more readable).

To apply range names to an existing formula:

Select the cell (or range of cells) with the formula(s). Then use the Insert/Name/Apply menu item, highlight any
relevant range names for the formula(s) involved, and click on OK.

Try it! Apply the names of the cells B2 and B3 to the formulas in row 7.

Month

Fixed cost
Variable cost

Units produced
Total cost

$50

Jan
224
$498

Feb Mar Apr
194 228 258
$438 $506 $566

To see a list of all range names and check which ranges they apply to:

Click on the down arrow at the right of the name box and click on any of the range names you see. That range will

then be selected automatically.

Try it! There are five named ranges below. Locate them.
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73 4 28

92 29 10

31 38 35

60 2 40

49 45 5

22 12 44

39 6 21

88

98 Junk Junk Junk Junk

Sometimes it is straightforward to use range names in formulas. For example, if B20 is named Revenue and B21 is
named Cost, then entering the formula =Revenue-Cost in, say, cell B22 is a natural thing to do. But consider this
situation. The range B3:B14 contains revenues for each of 12 months, and its range name is Revenues. Similarly,
C3:C14 contains costs, and its range name is Costs. For each month you want that month’s revenue minus cost in
the appropriate cell in column D. You will get it correct if you select the range D3:D14, type the formula
=Revenues-Costs, and press Ctrl-Enter. If you click on any cell in this range, you'll see the formula =Revenues-
Costs.

This can be confusing. How does Excel know that the formula in D3, for example, is really =B3-C3? Let’s just say
that it’s smart enough to figure this out. If it confuses you, however, you can always enter =B3-C3 and copy it
down. Then you’re safe, but you’ve lost the advantage of range names!

Try it! Enter the formula for all of D3:D14 using range names. (If you like, calculate profits again in column E in the
usual way, without range names.)

Revenues Costs Profits

$1,600 $1,400
$2,000 $1,800
$2,100 $1,800
$2,900 $2,800

$500 $400
$1,700 $1,500
$2,000 $1,900
$2,500 $2,300

Useful functions

There are many useful functions in Excel. You should become familiar with the ones most useful to you (for
example, financial analysts should learn the financial functions), but here are a few everyone should know. (By the
way, we capitalize the names of these functions just for emphasis. However, they are not case sensitive. You can
enter SUM or sum, for example, with the same result.)

To use the SUM function:

Enter the formula =SUM(range), where range is any range. This sums the numerical values in the range.
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Actually, it is possible to include more than one range in a SUM formula, so long as they are separated by commas.
(This can also be done with the COUNT, COUNTA, AVERAGE, MAX, and MIN functions discussed below.) For
example, =SUM(B5,C10:D12,Revenues) is allowable (where Revenues is a name for some range). The result is the
sum of the numerical values in all these ranges combined. Note that if any cells in any of these ranges contain a
label (not a number), it is ignored in the sum.

Try it! Use the SUM function in cell B10 to calculate the total of all costs.

Table of costs for units produced in one month (along side)
for use in another month (along top)

Feb Mar Apr May
Jan $5,000  $5,500  $4,400  $3,900
Feb $6,100  $5,400  $4,700
Mar $4,300  $6,900
Apr $4,900

Total cost

To use the COUNT function:
Enter the formula =COUNT(range), where range is any range. This produces the number of numerical values in the
range.

There is a similar function, COUNTA, which counts all of the cells, numerical or otherwise, in the range(s). For
example, if cells A1, A2, and A3 contain Month, 1, and 2, respectively, then =COUNT(A1:A3) yields 2, whereas
=COUNTA(A1:A3) yields 3.

Try it! Use the COUNT and COUNTA functions to fill in cells E1 and E2. Note that there are students below the
visible portion of the spreadsheet.

Student ID Exam score Number enrolled
3416 62 Number who took exam
6125 73
1535 74
2323 Absent
577 77
9044 57
8403 67
5892 90
4242 77

To use the AVERAGE function:
Enter the formula =AVERAGE(range) where range is any range. This produces the average of the numerical values
in the range.
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Be aware that the AVERAGE function ignores labels and blank cells in the average. So, for example, if the range
C3:C50 includes scores for students on a test, but cells C6 and C32 are blank because these students haven’t yet
taken the test, then =AVERAGE(C3:C50) averages only the scores for the students who took the test. (It doesn’t
automatically average in zeroes for the two who didn’t take the test.)

Try it! Use the AVERAGE function to calculate the averages in cells B1 and B2. (For B2, you'll have to replicate the
exam scores in column C and make some changes.)

Average exam score
(for students who took
the exam)

Average exam score
(if absent students get

zeroes)

Student ID Exam score
1533 68
8031 74
9859 80
9106 63
3535 72

8192 Absent

To use MAX and MIN functions:
Enter the formula =MAX(range) or =MIN(range) where range is any range. These produce the obvious results: the
maximum (or minimum) value in the range.

Try it! Use the MAX and MIN functions to fill in the range B8:C9. For example, you want the values $2300 and
$3600 in cells B8 and C9.

Sales rep Allison Baker Jones Miller Smith Taylor
Jan sales $3,700 $2,400 $2,300 $3,000 $3,800 $3,700
Feb sales $2,600 $2,200 $2,400 $2,800 $3,600 $2,300

Min sales Max sales
Jan
Feb

Using the function (fx) button in the top toolbar
If you haven’t used this button, you should give it a try. It not only lists all the functions available in Excel (by
category), but it also leads you through the use of them. As an example, suppose you know there is an Excel
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function that does net present value, but you’re not sure what its name is or how to use it. You could proceed as
follows.

To use the paste function wizard:

Select a blank cell where you want the function to go. Press the fx button and click on the category that seems
most appropriate (Financial in this case). Scan through the list for a likely candidate and select it (try NPV). At this
point you can get help, or you can press the Next button and enter the appropriate arguments for the function
(discount rate and one or more ranges of values).

Try it! Use the function wizard to help you determine the function in cell B6. Use the range names in cells B3
through B5 for improved readability. (Scroll to the right to see the correct formula.)

Payments for Mr. Jones, who just bought a new car

Amount financed $15,000
Annual interest rate 8.90%
Term (number of months financed) 36

Monthly payment :

Calculating Data with Advanced Formulas

Manage Cell and Range Names
Moving to the top of the sheet

Often you want to reorient yourself by going back to the “home” position on the worksheet.
To go to the top left of the sheet (cell Al):

Press Ctrl-Home (both keys at once).

Using range names

Range names are extremely useful for making your formulas more understandable. After all, which formula makes
more sense: =B20-B21 or =Revenue-Cost? Efficient use of range names takes some experience, but here are a few
useful tips.

To create a range name:

Select a range that you want to name. Then type the desired range name in the upper left “name box” on the
screen. (This box is just above the column A heading. It usually shows the cell address, such as E13, where the
cursor is.)

You could go through the Formula ribbon and under the Defined Names tab and select Name Manager item, but
typing in the name box is quicker and more intuitive. By the way, range names are not case sensitive. For
example, Revenue, revenue, and REVENUE can be used interchangeably.
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Try it! Name the rectangular range containing the numbers Data.

71 31 9 69 5
15 74 46 84 27
14 49 25 38 83
40 43 20 75 83
28 72 30 92 75
41 56 90 89 73
28 81 43 81 61

To delete a range name:

Use the Formula ribbon and under the Defined Names tab and select Name Manager. This shows a list of all
range names in your workbook. Click on the one you want to delete, and then click on the delete button.

Try it! The numerical range is currently named Data. Delete this range name and then rename the range
Database.

15 86 50 41 21
63 18 10 1 9
14 52 16 18 65
89 88 28 72 7
15 28 57 92 2
29 90 86 100 83
10 82 100 65 4

Suppose you have the labels Revenue, Cost, and Profit in cells A20, A21, and A22, and you would like the cells B20,
B21, and B22 (which will contain the values of revenue, cost, and profit) to have these range names. Here’s how to
do it quickly.

To create range names from adjacent labels:

Select the range consisting of the labels and the cells to be named (A20:B22). Then use the Insert/Name/Create
menu item, make sure the appropriate box (in this case, Left Column) is checked, and click on OK.

Excel tries (usually successfully) to guess where the labels are that you want to use as range names. If it guesses
incorrectly, you can always override its guess.

Try it! Name the ranges A3:A8, B3:B8, and so on according to the labels in row 2.
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Month UnitsSold UnitPrice Revenue

Jan 100 $1.25 $125.00
Feb 150 $1.25 $187.50
Mar 200 $1.40 $280.00
Apr 230 $1.40 $322.00
May 200 $1.50 $300.00
Jun 300 $1.50 $450.00

Sometimes you have entered a formula using cell addresses, such as =B20-B21. Later, you name B20 as Revenue
and B21 as Cost. The formula does not change to =Revenue-Cost automatically. However, you can make it change
(and hence become more readable).

Fixed cost $50
Variable cost $2
Month Jan Feb Mar Apr
Units produced 224 194 228 258
Total cost $498 $438 $506 $566

Calculate Data Across Worksheets
Worksheets provide a logical and intuitive way to organize your data in Microsoft Excel. Frequently, multiple
worksheets are used to further separate data into categories such as date or product type.

The ability to work with data in multiple worksheets is a necessary skill for Excel users. For example, you may
wonder: Is it possible to enter the same data into several worksheets without retyping or copying and pasting the
text into each one? Or, how can you easily sum the cell values across multiple worksheets? Or, how can you list the
names of the worksheets in your workbook?

Sum the value of a cell across multiple worksheets

Another common Excel task is to sum the value of a cell in multiple worksheets and then display the result in
another cell. For example, you may want to sum the number of a particular product that customers have ordered
over a period of time, such as by quarterly periods. If worksheets are formatted in the same way for each period,
the total sales for the product always appears in the same cell in each worksheet.

Finding the sum in this situation is simple. You can use a formula:
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1. Start Excel. A new, blank workbook appears.

2. Incell B3 in Sheetl, type 20.

3. Incell B3 in both Sheet2 and Sheet3, type 30.

4. Incell Alin Sheetl, type the following formula:
=SUM(Sheet1:Sheet3!B3)

5. Press ENTER. Notice that cell Al displays 80, which is the total sum of the cells in the three worksheets.

Enter data in multiple worksheets at the same time

As an example, let's say you want to put the same title text into different worksheets. One way to do this is to type
the text in one worksheet, and then copy and paste the text into the other worksheets. If you have several
worksheets, this can be very tedious.

An easier way to do this is to use the CTRL key:
1. Start Excel. A new, blank workbook appears.
2. Press and hold the CTRL key, and then click Sheet1, Sheet2, and Sheet3.
3. Clickin cell Al in Sheetl, and then type: This data will appear in each sheet.

4. Click Sheet2 and notice that the text you just typed in Sheetl also appears in cell Al of Sheet2. The text
also appears in Sheet3.

Use Specialized Functions
Analyze Data with Logical and Lookup Functions

Function Description
AND function Returns TRUE if all of its arguments are TRUE
IF function Specifies a logical test to perform
IFERROR function Returns a value you specify if a formula evaluates to an error; otherwise, returns
the result of the formula
OR function Returns TRUE if any argument is TRUE
TRUE function Returns the logical value TRUE
AND function
Description

Returns TRUE if all its arguments evaluate to TRUE; returns FALSE if one or more arguments evaluate to FALSE.

One common use for the AND function is to expand the usefulness of other functions that perform logical tests.
For example, the IF function performs a logical test and then returns one value if the test evaluates to TRUE and
another value if the test evaluates to FALSE. By using the AND function as the logical test argument of the IF
function, you can test many different conditions instead of just one.
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Syntax
AND(logicall, [logical2], ...)

The AND function syntax has the following arguments:

e logicall Required. The first condition that you want to test that can evaluate to either TRUE or FALSE.
e logical2, ... Optional. Additional conditions that you want to test that can evaluate to either TRUE or
FALSE, up to a maximum of 255 conditions.

OR function
Description

Returns TRUE if any argument is TRUE; returns FALSE if all arguments are FALSE.
Syntax
OR(logicall, [logical2], ...)

The OR function syntax has the following arguments:

e logicall, logical2, ... Logicallis required, subsequent logical values are optional. 1 to 255 conditions
you want to test that can be either TRUE or FALSE.
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[F function
Description

The IF function returns one value if a condition you specify evaluates to TRUE, and another value if that condition
evaluates to FALSE. For example, the formula =IF(A1>10,"Over 10","10 or less") returns "Over 10" if Al is greater
than 10, and "10 or less" if Al is less than or equal to 10.

Syntax

IF(logical_test, [value_if true], [value_if false])

The IF function syntax has the following arguments.

Logical_test Required. Any value or expression that can be evaluated to TRUE or FALSE. For example, A10=100 is
a logical expression; if the value in cell A10 is equal to 100, the expression evaluates to TRUE. Otherwise, the
expression evaluates to FALSE. This argument can use any comparison calculation operator.

Value_if_true Optional. The value that you want to be returned if the logical_test argument evaluates to TRUE.
For example, if the value of this argument is the text string "Within budget" and the logical_test argument
evaluates to TRUE, the IF function returns the text "Within budget." If logical_test evaluates to TRUE and the
value_if_true argument is omitted (that is, there is only a comma following the logical_test argument), the IF
function returns 0 (zero). To display the word TRUE, use the logical value TRUE for the value_if_true argument.

Value_if_false Optional. The value that you want to be returned if the logical_test argument evaluates to FALSE.
For example, if the value of this argument is the text string "Over budget" and the logical_test argument evaluates
to FALSE, the IF function returns the text "Over budget." If logical_test evaluates to FALSE and the value_if_false
argument is omitted, (that is, there is no comma following the value_if true argument), the IF function returns the
logical value FALSE. If logical_test evaluates to FALSE and the value of the value_if_false argument is blank (that is,
there is only a comma following the value_if_true argument), the IF function returns the value O (zero).

Remarks

Up to 64 IF functions can be nested as Value_if_true and Value_if_false arguments to construct more elaborate
tests. (See Example 3 for a sample of nested IF functions.) Alternatively, to test many conditions, consider using the
LOOKUP, VLOOKUP, HLOOKUP, or CHOOSE functions. (See Example 4 for a sample of the LOOKUP function.)

If any of the arguments to IF are arrays, every element of the array is evaluated when the IF statement is carried
out.

Excel provides additional functions that can be used to analyze your data based on a condition. For example, to
count the number of occurrences of a string of text or a number within a range of cells, use the COUNTIF or the
COUNTIFS worksheet functions. To calculate a sum based on a string of text or a number within a range, use the
SUMIF or the SUMIFS worksheet functions.
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VLOOKUP function
Description

You can use the VLOOKUP function to search the first column of a range of cells, and then return a value from any
cell on the same row of the range. For example, suppose that you have a list of employees contained in the range
A2:C10. The employees' ID numbers are stored in the first column of the range, as shown in the following
illustration.

A B C
1 EmployeeID Department Full Name
2 35 Sales Yossi Banai
3 36 Production Micole Bousseau
4 37 Sales Aik Chen
5 38 Operations Axel Delgado
6 39 Sales Suroor Fatima
7 40 Production Gerhard Goeschl
8 41 Sales Andreas Hauser
9 42 Operations Mattorn Jayanama

10 43 Production Jim Kim

FIGURE 9 A RANGE OF CELLS ON A WORKSHEET

If you know the employee's ID number, you can use the VLOOKUP function to return either the department or the
name of that employee. To obtain the name of employee number 38, you can use the formula =VLOOKUP(38,
A2:C10, 3, FALSE). This formula searches for the value 38 in the first column of the range A2:C10, and then returns
the value that is contained in the third column of the range and on the same row as the lookup value ("Axel
Delgado").

The V in VLOOKUP stands for vertical. Use VLOOKUP instead of HLOOKUP when your comparison values are
located in a column to the left of the data that you want to find.

Syntax

VLOOKUP(lookup_value, table_array, col_index_num, [range_lookup])

The VLOOKUP function syntax has the following arguments:

o lookup_value Required. The value to search in the first column of the table or range. The
lookup_value argument can be a value or a reference. If the value you supply for the lookup_value
argument is smaller than the smallest value in the first column of the table_array argument, VLOOKUP
returns the #N/A error value.

e table_array Required. The range of cells that contains the data. You can use a reference to a range
(for example, A2:D8), or a range name. The values in the first column of table_array are the values
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searched by lookup_value. These values can be text, numbers, or logical values. Uppercase and
lowercase text are equivalent.

e col_index_num Required. The column number in the table_array argument from which the matching
value must be returned. A col_index_num argument of 1 returns the value in the first column in
table_array; a col_index_num of 2 returns the value in the second column in table_array, and so on.

If the col_index_num argument is:

o Lessthan 1, VLOOKUP returns the #VALUE! error value.
Greater than the number of columns in table_array, VLOOKUP returns the #REF! error value.

e range_lookup Optional. A logical value that specifies whether you want VLOOKUP to find an exact
match or an approximate match:
o Ifrange_lookup is either TRUE or is omitted, an exact or approximate match is returned. If
an exact match is not found, the next largest value that is less than lookup_value is returned.

Important If range_lookup is either TRUE or is omitted, the values in the first column of table_array must
be placed in ascending sort order; otherwise, VLOOKUP might not return the correct value.

For more information, see Sort data in a range or table.

If range_lookup is FALSE, the values in the first column of table_array do not need to be sorted.

e Ifthe range_lookup argument is FALSE, VLOOKUP will find only an exact match. If there are two or more
values in the first column of table_array that match the lookup_value, the first value found is used. If an exact
match is not found, the error value #N/A is returned.

Index/Match Function
Now that you know the basics of these two functions, | believe it has already started making sense how Excel's

MATCH and INDEX work together.

The MATCH function determines the relative position of the lookup value in the specified range of cells. From
there, the INDEX function takes that number, or numbers, and returns a value in the corresponding cell.

Still having difficulties to figure it out? Think about Excel INDEX / MATCH in this way:

=INDEX (column to return a value from, MATCH (lookup value, column to look up against, 0))
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| believe it's even easier to understand from an example. Suppose you have a list of national capitals like this:

A B C ]

il Rank  Country Capital Population

2 1 China Beijing 20,693,000
3 2 India New Delhi 17,838,842
4 3 Japan Tokyo 13,189,000
3 4 Russia Moscow 11,541,000
& 5 South Korea Seoul 10,528,774
7 6 Indonesia Jakarta 10,187,595
8 7 Iran Tehran 9,110,347
9 8 Mexico Mexico City 8,851,080
10 9 Peru Lima 8,481,415

Let's find the population of some capital, say the capital of Japan, using the following Index Match formula:
=INDEX($D$2:5D$10,MATCH("Japan",$B$2:5B$10,0))
Now, let's analyze what each component of this formula actually does:

e The MATCH function searches for the lookup value "Japan" in column B, more precisely cells B2:B10, and
returns the number 3, because "Japan" is the third in the list.

e The INDEX functions takes "3" in the second parameter (row_num), which indicates which row you want
to return a value from, and turns into a simple =INDEX($D$2:$D$10,3). Translated into plain English, the
formula reads: search in cells D2 through D10 and return a value of the cell in the 3™ row, i.e. cell D4,
because we start counting from the second row.

And here's the result you get in Excel:

G2 - fr | =INDEX($D$2:3D$10,MATCH("Japan",$B$2:38510,0))
A B C D E F G

|| Rank Capital Population

2 1 China Beijing 20,693,000 Population of

3 2 India Mew Delhi 17,838,842 Japan's capital: | 13,185,000 1

4 3 Japan Tokyo 13,189,000

o 4 Russia Moscow 11,541,000

(5] 5 South Korea Seoul 10,528,774

7 6 Indonesia Jakarta 10,187,595

8 7 Iran Tehran 9,110,347

2! 8 Mexico Mexico City 8,851,080

10 9 Peru Lima 8,481,415
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Important! The number of rows and columns in the INDEX array should match those in the row_num or/and
column_num parameters of the MATCH functions, respectively. Otherwise, the formula will return incorrect result.

Wait, wait... why don't we simply use the following Vlookup formula? What's the point in wasting time trying to
figure out the arcane twists of Excel's MATCH / INDEX?

=VLOOKUP("Japan",$B$2:5D$2,3)

In this case, no point at all :) This simple example is for demonstration purposes only, so that you get a feel of how
the Index and Match functions work together. Other examples that follow below will show you the real power of
the INDEX MATCH liaison that easily copes with many complex scenarios when VLOOKUP stumbles.
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Presenting Data Using Charts

Create a Chart
Step 1: Create a basic chart

For most charts, such as column and bar charts, you can plot the data that you arrange in rows or columns on a
worksheet into a chart. However, some chart types (such as pie and bubble charts) require a specific data
arrangement.

1. Onthe worksheet, arrange the data that you want to plot in a chart.

The data can be arranged in rows or columns — Excel automatically determines the best way to plot the data
in the chart. Some chart types (such as pie and bubble charts) require a specific data arrangement.

Show How to arrange data on the worksheet
2. Select the cells that contain the data that you want to use for the chart.

Tip If you select only one cell, Excel automatically plots all cells that contain data that is adjacent to that cell
into a chart. If the cells that you want to plot in a chart are not in a continuous range, you can select
nonadjacent cells or ranges as long as the selection forms a rectangle. You can also hide the rows or columns
that you do not want to plot in the chart.

Show How to select cells, ranges, rows, or columns

3. Onthe Insert tab, in the Charts group, do one of the following:

Click the chart type, and then click a chart subtype that you want to use.

To see all available chart types, click L‘ to launch the Insert Chart dialog box, and then click the arrows to
scroll through the chart types.

TIROK BN IR

Calumn Line Pie Bar Area Scatter Other
- i i - - - Charts =
Charts P

Tip A ScreenTip displays the chart type name when you rest the mouse pointer over any chart type or chart
subtype. For more information about the chart types that you can use, see Available chart types.
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4. By default, the chart is placed on the worksheet as an embedded chart. If you want to place the chartin a
separate chart sheet, you can change its location by doing the following:

Click anywhere in the embedded chart to activate it.

o This displays the Chart Tools, adding the Design, Layout, and Format tabs.

On the Design tab, in the Location group, click Move Chart.

Under Choose where you want the chart to be placed, do one of the following:

To display the chart in a chart sheet, click New sheet.

= Tip If youwant to replace the suggested name for the chart, you can type a new name
in the New sheet box.

e Todisplay the chart as an embedded chart in a worksheet, click Object in, and then click
a worksheet in the Object in box.

5. Excel automatically assigns a name to the chart, such as Chart1 if it is the first chart that you create on a
worksheet. To change the name of the chart, do the following:

1. Click the chart.

2. Onthe Layout tab, in the Properties group, click the Chart Name text box.

Tip If necessary, click the Properties icon in the Properties group to expand the group.

3. Type anew name.

4. Press ENTER.
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Analyzing Data Using PivotTables and PivotCharts
Create a PivotTable Report

A PivotTable report is an interactive way to quickly summarize large amounts of data. Use a PivotTable report to
analyze numerical data in detail and to answer unanticipated questions about your data. A PivotTable report is
especially designed for:

e Querying large amounts of data in many user-friendly ways.

e Subtotaling and aggregating numeric data, summarizing data by categories and subcategories, and creating
custom calculations and formulas.

e Expanding and collapsing levels of data to focus your results, and drilling down to details from the summary
data for areas of interest to you.

e Moving rows to columns or columns to rows (or "pivoting") to see different summaries of the source data.

e Filtering, sorting, grouping, and conditionally formatting the most useful and interesting subset of data to
enable you to focus on the information that you want.

e Presenting concise, attractive, and annotated online or printed reports.

You often use a PivotTable report when you want to analyze related totals, especially when you have a long list of
figures to sum and you want to compare several facts about each figure. In the PivotTable report illustrated below,
you can easily see how the third-quarter golf sales in cell F3 compare to sales for another sport, or quarter, or to
the total sales.

To create a PivotTable or PivotChart report, you must connect to a data source and enter the report's location.
1. Select a cellin a range of cells, or put the insertion point inside of a Microsoft Office Excel table.
Make sure that the range of cells has column headings.

2. Select the type of report to generate by doing one of the following:

To create a PivotTable report, on the Insert tab, in the Tables group, click PivotTable, and then click

PivotTable.
o— o
1% -

PivotTable Table

-

Tables
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Excel displays the Create PivotTable dialog box.

e To create a PivotTable and PivotChart report, on the Insert tab, in the Tables group, click PivotTable,
and then click PivotChart.

Excel displays the Create PivotTable with PivotChart dialog box.

3. Select a data source

4. Specify a location by doing one of the following:

e To place the PivotTable report in a new worksheet starting at cell A1, click New Worksheet.

e To place the PivotTable report in an existing worksheet, select Existing Worksheet, and then specify
the first cell in the range of cells where you want to position the PivotTable report.

5. Click OK.
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Appendix
Keyboard Shortcuts

e Select all contents
Ct r | +A ¢ Select the contents of a table
Ct r I + N ¢ Create a new workbook

Ct r I + O *Open an existing workbook

Ct r | +S *Save a workbook

Ct r' | + F eSearch in a spreadsheet, or use Find and Replace
Ct r|+X ¢ Cut contents of a cell, selected data, or selected cell range
Ct r‘|+C * Copy contents of a cell, selected data, or selected cell range

Ct r I -|-V ¢ Paste contents of a cell, selected data, or selected cell range
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